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After using Mozilla Thunderbird for some time I decided to write an interface between Windows and Thunderbird, an
interface which would allow the user to move the Profiles.ini and Profile folders, to be able to reconstruct his system in
case he lost or accidently deleted his important files, an interface which would keep Profile names synchronized with
folder names giving the user more control of the system, an interface that would allow the user to run Thunderbird
from removable devices. This is what Sphinx does, while trying not to trouble the user by asking a lot of difficult
questions, just performing and being very forgiving. 

Despite the fact that we did a lot of testing we can't guarantee that everything will be perfect, so before starting to use
Sphinx make a copy of your important data as you should of course always do. 
The software has been developed using Borland's Delphi. The Help file was setup using Microsoft's HTML Help
Workshop. Sphinx is Freeware. If you're interested you can even have the source code as long as you're not going to
commercialize it in any way or form and as long as you respect my copyrights. Sphinx was tested on systems using
Windows 2000 Professional, Windows XP running Service Pack 2 and Windows XP 64, Intel and AMD processors
for Thunderbird 0.8 - 1.5.0 release using onlyPOP3 accounts.



Chapter 1 Installing and Uninstalling Sphinx

 1.1 Installing Sphinx
1.2 Uninstalling Sphinx
1.3 Remarks about installing Sunbird



1.1 Installing Sphinx 

If you are planning to run Thunderbird/Sunbird from a removable drive, you should install Sphinx on that removable
device. Sphinx doesn't have to be installed into the Thunderbird/Sunbird directory. 
If for the time being you don't intend to run Thunderbird/Sunbird from a removable device, just install Sphinx on one
of your local drives. If after some time you change your mind and want to run Thundrrbird/Sunbird from a removable
device, just re-install Sphinx using a directory on that device. You are allowed to have multiple versions of Sphinx,
however the Sphinx installation software is only able to create one Sphinx desktop item. If you want to have multiples:
copy the desktop item and modify its properties as follows:

1. Right click the Sphinx icon on your Desktop
2. Select "Properties"
3. Change the "Target Field" (to what the directory Sphinx is located)
4. Click "OK"

See also Where to install Sphinx. 



1.1 Uninstalling Sphinx 

Uninstalling Sphinx is a three step process as described below. 

1. Use Sphinx Move Profiles.ini to move the Profiles.ini file to Thunderbird's default directory. In most cases this
directory will be: C:\Documents and Settings\User name\Application Data\Thunderbird. User name is the name you
used at login time. 

2. If you used Sunbird together with Sphinx copy your calender files to Sunbird's default directory. In most cases this
directory will be: C:\Documents and Settings\User\Application Data\Mozilla\Sunbird\Profiles. User name is the name
you used at login time. The first time you run Sunbird as a standalone application you will be able to import these
files. 

3. Run Sphinx uninstall.exe which can be found in the directory where you installed Sphinx. 



1.2 Remarks about installing Sunbird 

Sphinx fully supports Mozilla Sunbird. With Sphinx you will be able to run Sunbird standalone or together with
Thunderbird. 

In principle you simply need to run the Sunbird installer, however, we recommend you install Sunbird into your
Thunderbird directory. For example : if Thunderbird has been installed into the directory W:\Thunderbird, install
Sunbird into W:\Thunderbird\Sunbird. In this case you are always certain Sunbird will be available to you. The
calender files (named storage.sbd) are stored in a directory named Sunbird located in your profile directory: example
E:\MailFolder\01u79ob5.Username\Sunbird. Every user can have his own calender. The calender file will be
automatically created the first time you run Sunbird. Of course already existing calender files can be imported. (See
Sunbird's file menu). 



Chapter 2 Launching Sphinx

 2.0 How to start 
2.1 Remarks 
2.2 Create a new directory 



2.0 How to start 

Sphinx has been run previously.

To launch Sphinx just click the shortcut on your desktop. After displaying the introduction window Sphinx will
ask whether or not to use the last known workable settings. If yes, then Sphinx will first check if all files are still at the
known location. If this check is OK, Sphinx will start up immediately. If you don't want to use your last known
workable settings or these settings have for some reason been corrupted, Sphinx will display the following window. 

If you don't know on which drive your Thunderbird/Sunbird files are located, choose the option 'Search for
directories by Sphinx'. If you installed Thunderbird using Thunderbird's default directory then choose the option 'Use
default directories'. If you want to locate your directories manually choose the option 'Provide directories by user'.
We advise using the option 'Search for directories by Sphinx'. In case Sphinx can't find any valid Thunderbird
Profiles.ini it will automatically start a reconstruction wizard.
(see Reconstruct Profiles.ini) 

If you want to restore backups first, click .

This is the first time Sphinx has been run or you have reinstalled your OS.

After displaying the introduction window Sphinx will immediately display the above window. If you don't know on
which drive your Thunderbird/Sunbird files are located, choose the option 'Search for directories by Sphinx'. If you
installed Thunderbird using Thunderbird's default directory then choose the option 'Use default directories'. If you
want to locate your directories manually choose the option 'Provide directories by user'. We advise using the option
'Search for directories by Sphinx'. In case Sphinx can't find any valid Thunderbird Profiles.ini it will automatically start
a Profiles.ini (re)construction wizard (see Reconstruct Profiles.ini). If you reinstalled Windows OS, Sphinx and
Thunderbird see Reinstalling windows. 



2.2 Remarks

2.1.1 Use of copy/move profile 
2.1.2 About deleting Thunderbird and Sphinx files 



2.1.1 Use of Copy/Move Profile 

To use all possible options of Sphinx it's advisible to use the Copy/Move Profile option in the Sphinx Main menu after
running Sphinx for the first time. The Sphinx Copy option isn't a backup facility, it's a tool used if you lost your original
Profile folders and/or Profiles.ini file. Sphinx will use those copied Profile folders to reconstruct your system. For this
purpose you can't use copies made by other third party software because after using the Sphinx copy option, Sphinx
will write all information neccessary, to restore the copied Profile folder into it's original Profile folder, to a file named:
SphinxCopyInfo.ini. 

After each session of Sphinx, Sphinx will automatically create a backup of your Profiles.ini file. The file will be stored
in a directory named Sphinx\ProfIniBaks. This directory resides within the directory containing Thunderbird. This file
is helpful in case your Profiles.ini file has been deleted. There's an option in Sphinx to do this for you (see Reconstruct
Profiles.ini). 

Almost every user action will be logged and written into a file named SphinxLog.txt. The file resides in the above
mentioned Sphinx directory. You can view/empty/edit this file (see Options explained). The file enables you to look
back into the history of your system. 

After having runned Sphinx for the first time a file named Sphinx.ini is created. This file keeps information about the
location of your Profiles.ini. Be aware that for every system you're going to use a new entry will be created. Sphinx
will keep track where on each system your Profiles.ini is stored. This is done by using the Mac address of each
system. 



2.1.2 About deleting Thunderbird and Sphinx files 

In principle you are allowed to delete almost all files created by Sphinx without running into serious problems. It isn't
however not advisable to delete SphinxCopyInfo.ini files. Those files are absolutely essential in case you want to
restore Sphinx copied Profile folders. If those files are not available, Sphinx will not be able to discriminate between
original and copied Profile folders. Using copied Profile folders without this information will seriously damage your
system, fortunately without deleting anything (see Reconstruct Profiles.ini ). Sphinx will delete original Profile folders
after a Move or Delete (if you choosed the Delete Files options) Profile action.
However, deleted files will be put into your Recycle bin. After deleting (by accident) Profile folders or Profiles.ini,
Sphinx will still be able to reconstruct your system. After reconstruction you must move your files from the Recycle
bin to a safer place. For this purpose you can use the Copy/Move Profile option in Sphinx main menu. 

New directories created by Sphinx will be named following this simple rule: 
Directory name = Saltcode.Profilename. Saltcode is a random generated string of 8 alphanumeric characters.
Example: abvoos02.Default User 
A name, whether a Profile name or a directory name, may not start with a '.' or contain any of the following
characters: '/', '\', '#', '*', '?', '', '|' 
Sphinx will prevent you of using any of the mentioned characters. 

Important notice: if you start using Sphinx, don't start Thunderbird as a standalone application anymore. If you want to
stop using Sphinx see Uninstalling Sphinx. 



2.2 Create a new directory 

In some cases Sphinx will ask you whether or not you want to create a new directory. In those instances the following
window will be displayed: 

After selecting a directory from the left side of the window you do have two options. If you click the 
button your Profile folder will be created in the selected directory.

Example: you selected drive W:\ and clicked the option: Use Selected Directory. Your Profile folder will then be:
W:\Saltcode.UserName.(Saltcode: random generated 8 character code.) if you selected a subdirectory say Profiles
which resides within W:\Thunderbird\Sphinx, then your Profile folder, after creation, will be:
W:\Thunderbird\Sphinx\Profiles\Saltcode.UserName. 

If you click the button the next window will be displayed: 



Enter the name of the directory to be created. Clicking the Continue button will create the directory with the name of
your choice. Example: You selected the directory W:\Thunderbird\Sphinx. You want all your Profile folders within a
directory named 'MyProfiles'. Click the button, enter the name 'MyProfiles' and click the
Continue button. Your Profile folder, after creation, will be: W:\Thunderbird\Sphinx\MyProfiles\Saltcode.UserName. 

Keep in mind that a name may not start with a '.' or contain any of the following characters: '\', '/', '#', '?', ':', '*', '', '|' 
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3.0 Main window



3.1 File

3.1.1 Program options 
3.1.2 Profile options 
3.1.3 Sphinx ini manager 
3.1.4 Delete all .msf files 
3.1.5 Archiving 



3.1.1 Program options

3.1.1.1 View Profiles.ini 
3.1.1.2 Edit Profiles.ini 
3.1.1.3 View log file 
3.1.1.4 Clear log file 



3.1.1.1 View Profiles.ini

Will show you the contents of your current Profiles.ini file.



3.1.1.2 Edit Profiles.ini

Attention: only use this option if you do have in-depth knowledge of Thunderbird.
Making mistakes in editing this file may corrupt your entire installation.



3.1.1.3 View log file

This option will show you the contents of your log file. 



3.1.1.4 Clear log file

Your log file can grow very fast. A big log file can slow down the logging process.
We therefore advice you to check regulary your log file and clear it when the info is no longer needed. 



3.1.1 Profile options

3.1.1.1 View Profiles options 
3.1.1.2 Edit Profile options 



3.1.2.1 View Profile options

This option will show you the contents of Profile options files like: Prefs.js, User.js, Chrome.rdf etc.



3.1.2.2 Edit Profile options

Attention: only use this option if you do have in-depth knowledge of TB.
Making mistakes in editing those files may corrupt your entire installation.



3.1.3 Sphinx ini manager

Using Sphinx will give you the opportunity to define different locations for TB, SB, Profiles.ini and your Help file on, if
applicable, different systems.
At startup Sphinx will ask you which sets you want to use for TB/SB.
To view and/or delete sets use Sphinx ini manager. Below a sample window.

Mark sets you want to delete checking the box Mark to delete. Deletion will take place after clicking the button



3.1.4 Delete all msf (Mail Summary Files) files

If compacting folders does not seem to work even for a single folder it is possible that the Thunderbird's .msf are
corrupted.
One way to fix this problem: delete the files ending in .msf. Thunderbird recreates them when it starts.
There is no risk in deleting these files. The windows below will be displayed during the process



3.1.5 Archiving

Mail folders can occupy a lot of space on your hard drives.
If you have mail folders which you don't frequently use why not use archiving.
Archiving will compress their contents to use less space. 
After having been successfully archived Sphinx will on request send an email to remind you which mail folder has been
archived.
Archived mail is kept outside Thunderbird's focus so you will not see archives in your Thunderbird mail treeview. The
mail folder itself will still be available (empty after archiving) and usable.

Sphinx Archiving offers you a number of tools( see topics 3.1.5.1 - 3.1.5.5) to manage Archives. Archived mail will
be stored in your Profile folder in the directory SphinxZippedMail
using the following file naming: yy mm dd hh mm ss + the name of the folder you archived. 

Example

You could transfer your mail (including subfolders if you want) dated before 2005 into a seperate mail folder named
Oldmail 2005. To do this use Thunderbird message filters, then use Archiving to create an Archived folder which will
be named 'yy mm dd mm ss OldMail 2005'. After Sphinx completes the Archiving process it will ask you whether or
not it should send you a reminder.

Below is an example of such a reminder.
(Path and name depends of course upon your settings)

----------Start sample email----------

This message has been created by Sphinx in order to help you remember which folders you archived The following
folder has been archived: ...:\MailFolder\01u79ob5.UserName\Mail\Local Folders\OldMail 2005.sbd and put into
the folder: ...:\MailFolder\01u79ob5.UserName\zippedMailfolders For details please use the option: View files in
Archive in Sphinx file options and/or your logfile. It's save to delete this message, however we advice you to move
this message into the corresponding mail folder: OldMail 2005.
Don't reply to this message.

----------End sample email---------- 



3.1.5.1 Archive Mail folder(s)

The following window will be displayed

Choose which mail folders you want to archive and click the button.
After having archived your folder successfully Sphinx will aks you whether or not sent you a reminder. If you choose
to do so the next window will be displayed



Click on the email address, SMTP server name and port number you want to use. Clicking the button
will sent the email. 



3.1.5.2 Extract Mail folder(s) from Archive

Clicking this option will show you all available Archives for the current Profile.
Check from which Archives you to want to extract mail folders. 

Clicking the button will start the process. Mail folder(s) will be extracted and restored to their original
location(s).



3.1.5.3 Extract file(s) from Archive.

This option differs from 3.1.5.3 Extract Mail Folder(s) from Archive, which only allows you to extract a complete
mail folder.
This tool however allows you to select file(s) within your Archive to be restored.

Select the files you want to extract from the Archive and click the button Extract file(s).
File(s) will be extracted and restored to their original location(s). 



3.1.5.4 View files in Archive

This option will show you all Archives available for the current Profile. Just click the one the contents of which you
want to see.

A sample window is shown below. 



3.1.5.5 Delete file(s) from Archive

This option will show you all Archives available for the current Profile. Just click the one the contents of which you
want to see.
Select the file(s) you want to delete. Take great care in making your choices. This operation cannot be undone.
Deleted files will be deleted permanently from the Archive file.



3.1.5.6 Delete (complete) Archive

Deleting an Archive file cannot be undone!.

This option will show you all Archives available for the current Profile. Just click the one the contents of which you
want to see.
Clicking the Delete button will show you a warning message before starting the Delete process.(see below)



3.2 Tools

3.2.1 Move Profiles.ini 
3.2.1 Copy/Move Profile 
3.2.3 Combine Profiles.ini 
3.2.4 Backup 
3.2.5 View all TB related info 
3.2.6 Recover deleted messages 
3.2.7 Compact folders 
3.2.8 SphinxTrashBin 



3.2.1 Move Profiles.ini 

Perhaps the most important option: Sphinx makes it possible to move your Profiles.ini to different locations within
your system. This option makes it possible to run TB from a Memory stick or removable drive. If you want to know
where your Profiles.ini is located, just click the Label named 'Profiles.ini'. 

Clicking the button will display the following window containing important information. 

Clicking the button Continue will present you the next window: 



Select one of the directories shown in the left hand window and click button. Your
Profiles.ini will be moved. 



3.2.2 Copy/Move Profile 

Sphinx Copy/Move option will not alter the contents of your Profile's folder, it will only Copy/Move entire folders and

their contents, no file compression is used. After having selected a iconed Profile name from the right top
window and having clicked the button the following window will be displayed: 

Attention: Read the displayed warning messages in the above window

 Whatever option you choose, Sphinx will ask you where to move or copy your Profile folder and all its contents
using the 'directory display' windows already shown under topic Creating a new directory. 

If you Copy a Profile, Sphinx will create a SphinxCopyInfo.ini file. This file contains important information about the
copy process such as: the source directory, the target directory, date and time the copy took place, MAC address of
the system on which the copy took place and the name of the user who executed the copy command. The file will be
created in the copied Profile folder as specified by the user. Under NO CIRCUMSTANCES delete the file
SphinxCopyInfo.ini. If you want to restore a Profile folder, Sphinx will need this file. It will be of crucial importance in
case of emergency. If you Move a Profile, Sphinx will not only update your Profiles.ini and AutoBackupInfo.ini but
also all important files including: the corresponding Chrome.rdf, and Calendar.rdf if you installed the Thunderbird
Calendar extension in order to keep everything synchronized. 

Remarks: 
(1) up to now only the following extensions have been tested and found operational after a Move Profile: Calendar,
Enigmail, SMTP buttons. SB calender files are also operational after a Move Profile. 
(2) you can restore a Sphinx copied folder manually, however after restoring, you have to delete the file:
SphinxCopyInfo.ini. 
(3) DON'T manually restore a MOVED folder. In doing this the following files will no longer be synchronized:
Prefs.js, Chrome.rdf. Thunderbird will not be able to correctly use the folder.
(4) We strongly advise you to backup your total system after having moved your Profile. In doing this you will be
100% sure that the pathnames of all your backed-up files and folders have been updated. 

See also: 



Move installation. 
Restore backups. 
Backup total system. 



3.2.3 Combine Profiles.ini

If you do have more than one Profiles.ini file you can combine them using this option.
Upon launching this option you will be asked if Sphinx should start searching your system for Profiles.ini files. 
If yes a search will start and Sphinx will display ALL Profiles.ini files found including non- Thunderbird files.

Select the Profiles.ini file you want to use. On clicking the contents of the selected file will be displayed in the top most
right window.
To be sure this is a valid Profiles.ini file click on Path= Sphinx will show you the contents of the Prefs.js file which is
connected to the Profiles.ini file you selected.
Sphinx will advise whether or not it's safe to use this Profiles.ini file for combination purposes. We strongly advise you
to manually check the selected Profiles.ini and Prefs.js files, see windows below.





If you decide it's safe to combine the selected Profiles.ini files, click the button.
The next window will be displayed showing the result of combining the selected Profiles.ini files into one.



Clicking the button will create the new Profiles.ini file. Clicking the will abort the operation
leaving everything as it was. 



3.2.4 Back-up

3.2.4.1 Back-up single profile 
3.2.4.2 Back-up files/folders 
3.2.4.3 Back-up mail folders 
3.2.4.4 Restore back-ups 



3.2.4.1 Back-up single profile

Back-up a complete Mozilla Thunderbird profile including: Profiles.ini, Mail, Sphinx.ini, Extensions, Calender,
SphinxZippedMail, SphinxAutoBackupInfo, SphinxTrashBin and Chrome folder.
(Actually every file and/or folder within the Profile will be backed-up)

Back-up created will be compressed and can be protected with a password. Do not forget your password. We will
not be able to help you in case you did.
You have to define the location of your back-up. Sphinx does not keep track of the location you used.

Attention: all files and folders in the back-up have their full pathnames attached. 

See also: Schedule back-up.



3.2.4.2 Back-up files/folders

ONLY back-up selected files in your Profile folder, SphinxTrashBin and zippedMailFolfers if selected. Do not worry
if SphinxTrashBin and/or SphinxZippedMail do not exist.
The back-up created will be compressed and can be protected with a password. Do not forget your password. We
will not be able to help you if you do.
You have to define the location of your back-up. Sphinx does not keep track of the location used.



3.2.4.3 Back-up mail folders

This option will only allow you to back-up selected mail folders for the current Profile.
Back-up created will be compressed and can be protected with a password. Do not forget your password. We will
not be able to help you in case you did.
You have to define the location of your back-up. Sphinx does not keep track of the location used.



3.2.4.4 Restore back-ups

Sphinx will restore the contents of the selected back-up to it's original location.
You have to browse to the back-up to restore. If the back-up is password protected, the system will prompt for the
password.

Attention: the Restore procedure will use the stored full pathname of every file and folder in the back-up. 
You will NOT be able to redirect the location of any file or folder within your back-up.
Permission to overwrite has to be acknowledged. You will be able to rename the file or folder to restore.



3.2.5 View all Thunderbird related info

Select a file from the right side of the window.
Sphinx will show you the contents of the file. All files are displayed in plain text format. This means that attachments
will be displayed in hexidecimal characters. 
Displaying large mail folders can take some time so please be patient. 
To look inside files with the JAR extension, you need to have Winzip or 7-Zip being installed.
7-Zip is freeware and can be downloaded from http://www.7-zip.org 

http://www.7-zip.org


3.2.6 Recover deleted messages

If you, by accident, deleted messages from one of your mail folders and you DID NOT RUN Sphinx Compact, TB's
Compact utility or one of TB Compact extensions, this option gives you an opportunity to restore those deleted
messages. 

Right click on the message file from which you want to recover deleted messages. You are allowed to select more
than one file.

Click the button to start the recovery process. After completion Sphinx will show you the number of
recovered messages. 



3.2.7 Compact folders

When you delete a message in TB it is not immediately physically removed from the mailbox file but only hidden from
display. This speeds up things considerably,
but it also wastes valuable hard disk space. Compact Folders folders occasionally to reclaim that space for the
current account using Sphinx Compact folders.
Sphinx differs from all other Compact utilities in putting removed (deleted) messages into SphinxTrashBin. The
SphinxTrashBin option see SphinxTrashBin. will allow you to restore a complete set of during compacting 
removed (deleted) messages into a mailfolder named SphinxTrashedEmails, located in your Local Folders. So you
are able to compact your mail files and at the same time hold complete control over every single removed (deleted)
message.
Please follow the steps as shown in the Information window and below. Be aware of the fact that compacting large
mail folders can take some time.

How it works

Sphinx will check how much memory there is available for the compacting process, at least 20 Mb is needed.
After this test a check will be made regarding free disk space available on the drine where the mail file is located.
Sphinx needs a minimum amount of free disk space equal to the mail file size to be compacted. If all is OK the mail
file will be split into seperate files of which the size depends upon the memory found available by Sphinx. So for
example: your free memory space is about 750 Mb and the file size of the file under consideration is about 160 Mb.
Sphinx will allocate 10% of the free memory found for the compacting process, your file will be split up into 160/75 =
3 seperate files. (In case your mail file is smaller in file size than 75 Mb used in this example, there will of course be
just one splitfile). Sphinx will process those splitfiles: deleted messages will be written to the SphinxTrashBin, not
deleted one's into a tempory file. If the whole process ends successfully this last file is written to the original mail file
and all tempory files including the original mail summary file are deleted.

The way of doing compacting like this has a couple of advantages:
1. There is no limit to the mail file size you can compact.
2. The process is fast. In testing a 750 Mb file with over 30000 messages of which 24000 were deleted, compacting
just took about 350 seconds.
(Windows XP Professional, CPU AMD Turion64, RAM 2 Gb, reading/writing to a virtual encrypted disk located on
a USB portable drive).
3. It's very safe. If something happens during the process (power failure, system shut down), your original mail file will
not be affected.
4. Compacting doesn't need nor uses Thunderbird's mail summary files.
5. As long as you don't empty your SphinxTrashBin, your deleted messages are still available and can be restored.
(see SphinxTrashBin).

Disadvantage: after compacting Thunderbird has to rebuild your mail summary file which could take some extra time.





3.2.8 SphinxTrashBin

After each compact all messages removed will be stored in a SphinxTrashBox file. Those files will have an unique
name following: SphinxTrashedEmails + yy mm dd hh mm ss
Using SphinxTrashBin you will be able to restore such a file and recover your deleted mails. The
SphinxTrashedEmails files are ALWAYS restored into your Local Folder.



3.3 Schedules

3.3.1 Schedule back-up 
3.3.2 Schedule compacting 
3.3.3 Delete schedules 



3.3.1 Schedule back-up

As you can see in the window below Sphinx will show you all available Profile folders and their corresponding user
names. Clicking on a Profile folder will open it and display the contents.
From the contents window you are able to select the folders you want to backup on a regular basis. Backup will
always be run on the day(s) defined when Sphinx is shut down. 
Sphinx will ask the user whether or not the scheduled back-up should be ran.

Select the day(s) the back-up should be ran and select the number of back-ups (History) you want to keep before
overwritting them with new ones.
Using the button 'Set directory' define the location where your back-ups should be stored. The folder in which your
back-ups are going to be stored is ALWAYS named SphinxAutoBackups. The backup files are named: 
Profile name + AutoBackup + yy mm dd hh mm ss. If you want to use a password to protect your backup click the
button 'Set password' . Your password will be encrypted and saved into the file
SphinxAutoBackupInfo\SphinxAutoBackupInfo.ini' together with other back-up settings. The folder
SphinxAutoBackupInfo can be found in your Profile folder. Do not forget to save your Schedule after completing
clicking the button 'Save schedule'. We advise you to follow the steps as outlined in the Information window

Attention: saving a schedule will automatically overwrite an already existing one for the selected Profile.
If you want to see the contents of a possibly existing schedule use the option Delete/View schedules.





3.3.2 Schedule compacting

As you can see in the window below Sphinx will show you all available Profile folders and their corresponding user
names. Clicking on a Profile folder will open it and display its the contents. From the contents window you are able to
select the folders you want to compact on a regular basis. Compacting will always be run on the day(s) defined during
a shut down of Sphinx. Sphinx will ask the user whether or not the scheduled compacting should be ran.

Select day(s) the compact should be runned. Do not forget to save your Schedule after completing clicking the button
'Save schedule'. We advise you to follow the steps as outlined in the Information window.

Attention: saving a schedule will automatically overwrite an already existing one for the selected Profile.
If you want to see the contents of a possibly existing schedule use the option Delete/View schedules.



3.3.3 Delete/View schedules



3.4 Options

3.4.1 Quick Launch 
3.4.2 Hints 
3.4.3 Empty on Exit 



3.5.1 Quick launch

You can define different Quick launch settings for every separate computer system, however, Quick Launch can only
be set-up for one Profile.
If you don't choose any program to run but you did select a Profile, Sphinx main window will be started.



3.4.2 Hints

Use this options to switch showing Hints on and off. 



3.4.3 Empty on Exit

Option will empty ALL your Trash and Junk folders on exiting Sphinx.
Clicking this menu option will display the following window 

Make your choices by clicking the corresponding radiobuttons. Clicking the button will save your
settings. 





3.5.1 Sphinx help. 





3.6 Profile folder not found 

In case you select a Profile name which doesn't have a corresponding Profile folder, followed by a user action like
'Rename Profile', 'Copy/Move Profile', 'Start Thunderbird', Sphinx will immediately signal this event. Sphinx will ask
you whether or not it should start searching for a corresponding Profile folder. See the following window. 

. 

If you choose to click No: 
the system will display the next window: 

. 

Click the OK button to continue. For the time being, you'll not be able to use this Profile. 

If you choose to click Yes: 
Sphinx will start scanning all available drives (excluding Network drives). Profile folders found will be displayed using
the next window: 



Click the item you want to restore (Please, have a close look first at the topic below 'Important Remarks') and hit the
Continue button. If the folder you clicked is an ORIGINAL one Sphinx will update your Profiles.ini. However if the
item you clicked is representing a COPY of an original folder made using Sphinx Copy/Move option, Sphinx will
display a COPY Info Window 

If you choose to use this folder by clicking the button Sphinx will restore the folder into its original location and update
your Profiles.ini file. After this you can start using the Profile as you did before. 



3.7 Important remarks: 

(1) Scanning all drives for Profile folders WILL include your Recycle bin. If you are going to use the contents of the
Recycle bin DON'T forget to use the Move/Copy options in the Main menu to get the item out of the Recycle bin.
(see Copy/Move Profile). 
(2) If you choose to use a COPIED Profile folder, be sure the original one DOESN'T exists anymore. Restoring will
implicate overwritting a possibly still existing ORIGINAL folder and all its contents. 
(3)Don't use Profile folders which were copied/backed-up with software other than Sphinx. As mentioned earlier,
restoring by Sphinx, will need the file SphinxCopyInfo.ini. If you want to use a Profile folder which has been
backed-up/copied with other third party software, then terminate Sphinx and restore the Profile folder with the third
party software you used to make the back-up/copy. 



3.8 Rename Profile 

First, be aware of the fact that there is a fundamental difference between Renaming a Profile using the TB profile
manager and using Sphinx. Actually TB ONLY renames the entry in your Profiles.ini, that's all. So if you Rename a
Profile using TB, the connection between the Profile foldername in which all your data are stored and your Profile
name is lost. Contrary to this, Sphinx will rename not only the entry in Profiles.ini but also the above mentioned
foldername. In order to keep everything synchronized Sphinx also renames your entries in the user Prefs.js and if
necessary the Chrome.rdf file. 

TB doesn't allow duplicate Profile names. Sphinx does, however you'll not be allowed to use the renaming option with
duplicate names. There's another way to do this, please see Double clicking a pyramid iconed name . 

After having selected a iconed Profile name from the right top window, click the button. The
following window will be displayed : 

Just enter a new Name and click Continue. Keep in mind that a name may not start with a '.' or contain any of the
following characters: '\', '/', '#', '?', ':', '*', '', '|' and may not start with a '.' (dot/period). The system will prevent you
from doing this. 



3.9 Delete Selected Profile 

After having selected a iconed Profile name from the right top window, you will be able to delete it. Clicking the
button Sphinx will display the next window, asking what you actually want to delete. 

The option will not only remove your Profile name but will also DELETE ALL correponding files. In
contrast to TB, the deleted files will be put into your Recycle bin. 

The option will remove your Profile name but will leave all corresponding files in place. 



3.10 Create new Profile 

Clicking the button will display the following window: 

Clicking the Continue button will create a new Profile with the name you entered. The Profile directory will be created
using the default directory displayed. If you want the new Profile folder created in a directory of your choice click the 

button and proceed as described under the topic: Creating a new directory. 



3.11 Start Thunderbird 

After having selected a iconed Profile name from the right top window (one with an existing Prefs.js file), clicking
the button will launch Thunderbird, the Sphinx main menu will automatically be minimized to
your tray bar. Be aware of the fact that Thunderbird can be a really slow starter. 

After ending a Thunderbird session, Right clicking the Sphinx/Pyramid icon in your tray bar will show you a small
window with the following options: 'Show Form'; 'Hide Form'; 'Do not Animate Icon'; 'Exit'. In case Thunderbird isn't
running, clicking 'Exit' will terminate Sphinx immediately. However if Thunderbird is running, Sphinx will prompt you
to terminate Thunderbird first. Clicking 'Show Form' will display the Sphinx Main Menu. Clicking the option 'Do not
Animate Icon' will stop animating the Sphinx icon in the tray bar. 

There is always a possibilty the specified path to your profile folder is no longer valid. This will happen if you manually
moved your Profile folder. In this case after starting Thunderbird/Sunbird Sphinx will ask you whether or not to scan
your hard drives for valid Profile folders. If Profile folders are found Sphinx will ask you whetehr or not it shold
reconstruct your Profile.ini. 
(See windows below or Top Part of Main Menu ); 



Start Sunbird 

After having selected a iconed Profile name from the right top window, clicking the button
will launch Sunbird, the Sphinx main menu will automatically be put into your tray bar. 

After ending a Sunbird session, Right clicking the Sphinx/Pyramid icon in your tray bar will show you a small window
with the following options: 'Show Form'; 'Hide Form'; 'Do not Animate Icon'; 'Exit'. In case Sunbird isn't running,
clicking 'Exit' will terminate Sphinx immediately. However if Sunbird is running, Sphinx will prompt you to terminate
Sunbird first. Clicking 'Show Form' will display the Sphinx Main Menu. Clicking the option 'Do not Animate Icon' will
stop animating the Sphinx icon in the tray bar. 

There is always a possibilty the specified path to your profile folder is no longer valid. This will happen if you manually
moved your Profile folder. In this case after starting Thunderbird/Sunbird Sphinx will ask you whether or not to scan
your hard drives for valid Profile folders. If Profile folders are found Sphinx will ask you whether or not it should
reconstruct your Profile.ini. 

See also: Start Thunderbird



Start Thunderbird and Sunbird 

After having selected a iconed Profile name from the right top window (one with an existing Prefs.js file), clicking
the button will launch both Thunderbird and Sunbird, the Sphinx main menu will automatically
be put into your tray bar. 

After ending a Thunderbird/Sunbird session, right clicking the Sphinx/Pyramid icon in your tray bar will show you a
small window with the following options: 'Show Form'; 'Hide Form'; 'Do not Animate Icon'; 'Exit'. In case
Thunderbird/Sunbird isn't running, clicking 'Exit' will terminate Sphinx immediately. However if Thunderbird/Sunbird is
running, Sphinx will prompt you to terminate Thunderbird and Sunbird first. Clicking 'Show Form' will display the
Sphinx Main Menu. Clicking the option 'Do not Animate Icon' will stop animating the Sphinx icon in the tray bar. 

There is always a possibilty the specified path to your profile folder is no longer valid. This will happen if you manually
moved your Profile folder. In this case after starting Thunderbird/Sunbird Sphinx will ask you whether or not to scan
your hard drives for valid Profile folders. If Profile folders are found Sphinx will ask you whether or not it should
reconstruct your Profile.ini. 

See also: Start Thunderbird and Start Sunbird. 



3.14 Exit 

If TB/SB aren't running clicking the button will, in case TB/SB aren't running, terminate Sphinx
immediately. If Thunderbird/Sunbird are running, Sphinx will prompt you to terminate them first. 



Chapter 4 Clicking and double clicking entries 

5.0 Double clicking folder label 
5.1 Clicking a pyramid iconed name 
5.2 Double clicking a pyramid iconed name



4.0 Double clicking the folder label 

If the folder name isn't completly displayed, double clicking the folder label 
will give you an extended view of the folder presented. For an example

see below. 

Clicking the OK button will hide the displayed information. 



4.1 Clicking a pyramid iconed name 

Clicking a iconed name in the window on the left will show where all your files and folders are located which
belong to the Profile name selected in that window. Your root directory will be automatically set to your Main folder
containing the info about the name clicked. See below for an example. 



4.2 Double clicking a iconed name, Using duplicate Profile names 

Double clicking a pyramid iconed name presented in the window on the right will open the following window: 

Using this window you are not only able to rename a Profile but even enter an already existing Profile name without
running into problems. The principle is based on the fact that Sphinx like Thunderbird is using a so-called Saltcode to
create safe directories. Sphinx uses the complete directory name to discriminate between Profile names even if there
are duplicates. If no Saltcode is presented in the left part of this window, there is no reason to worry. Sphinx will
create a new one if it's not available. Your Profiles.ini and all other important files will be updated with the newly
entered name and if necessary the new Saltcode. 



Chapter 5 Reconstruct your Profiles.Ini file

 6.0 Introduction 
6.1 By creating a new Profile 
6.2 Using existing Profile folders 
6.3 Restoring a backup of Profiles.Ini 



5.0 Introduction

One of the most important options of Sphinx is its ability to reconstruct your Profiles.ini file if you accidently, or on
purpose, deleted it. If Sphinx isn't able to locate your Profiles.ini file, the reconstruction will automatically be initiated.
This is also true the FIRST time you launch Sphinx. There are three options for reconstruction as you can see from the
window below. 



5.1 By creating a new Default Profile 

In this case Sphinx will create a Profile named Sphinx User. The corresponding files are stored in the directory:
X:\Some directory name\Location of TB\Saltcode.Sphinx User. You of course have the possibility to rename this
Profile using the Rename Profile option in Sphinx Main menu, to move the Profiles.ini file or the Profiles folder using
Sphinx Main menu options, to whatever location you want. 



5.2 Using existing Profile folders 

The first step in this process will be Sphinx scanning all your local drives for valid Profile folders. (No Network drives
are included). After having found Profile folders Sphinx will display the next window: 

In the GREEN part of the window all original Profile folders are displayed. In the RED part all copied Profile folders
will be displayed. If an original Profile folder has been copied and showed in the GREEN part, it's copy will NOT
been shown in the RED part. There's no need to use a copied Profile folder if the original is still in place. (see below) 

Mutiple copies of the same original Profile folder will be shown. If you choose a copied Profile folder always check
the copy information provided. This will give you an exact view of the date and time the Profile folder was copied.
Double clicking on your selection will display the copy information. Using copied Profile folders, will restore them into
their original folder. So be sure the folder which is mentioned as being the 'source directory' in the copy information is
empty. You have to check this manually using for example Windows Explorer. 
After having selected all the Profile folders you want to use, click the button, Sphinx will start to
reconstruct your Profiles.ini file. If Sphinx isn't able to get the right Profile name, it will use default names starting with
the word 'Profile' followed by a number like: Profile01; Profile02.......etc. You always have the Rename Profile option
in the Sphinx main menu (see Rename Profiles). 
A possible reason Sphinx isn't able to get the original Profile names could be the fact that your Profile folder names
don't obey the naming rule: 'Saltcode.Profile name' as shown in the above displayed window. 

Note: Sphinx will scan your Recycle Bin. If you used files and/or folders from the Recycle Bin, don't forget to move
them to a safer place. (see Copy/Move Profile) 



5.3 Using a back-up of Profiles.ini 

As said before: everytime a Sphinx session is terminated, Sphinx will make a back-up of your existing Profiles.ini file. 
Those back-ups are stored in the directory X:\TB directory\Sphinx\BackupDir. The last 10 back-ups made by
Sphinx are stored. Take great care in choosing which backup you are going to use. In almost all cases you have to
use the latest version of the back-up. You're running great risks using old ones, for example: today you moved a
Profile or just renamed it. This will be reflected in todays back-up however not in the back-up Sphinx made just two
days ago. Restoring this old back-up is not going to reflect the current state of the system, in which case neither TB
nor Sphinx will act predictabily. Fortunately, if you make this mistake, Sphinx will be able to get things together again. 
(see Top Part of Main Menu). The next window will show you the layout of the found Profiles.ini backup files: 

Double clicking a selected backup will display the following window :

After having made the right selection, click the button, Sphinx will restore the back-up of the Profiles.ini.
The file will be stored in the source directory as shown in the above window. 



Chapter 6 Running Thunderbird from removable devices

 7.0 Where to install Sphinx 
7.1 Location of your Profile folders 
7.2 Possible configurations 



6.0 Where to install Sphinx 

If you want to run Thunderbird/Sunbird from a removable device it's advisable to have an instance of Sphinx installed
on the removable device where Thunderbird/Sunbird have been installed. In doing this, you'll be sure that Sphinx is
always available whatever system you're connected to. In case you connect your removable device to a computer
system which does not have Sphinx available, Thunderbird/Sunbird may not be able to run correctly. So always be
certain you have Sphinx available. If you run low on memory on your removable device, delete the Sphinx Help file
(SphinxHelp.chm). 



6.1 Location of your Profile folders 

Using Sphinx Copy/Move Profile you should move those Profile folders you want to have available on your
removable device to this device. You don't have to move all your Profile folders if you don't want. However, Profile
folders not on your removable will not be available if you connect your removable device to another computer system.
It's advisable also to move (Move Profiles.ini) your Profiles.ini to the removable device however this isn't a must. If
Sphinx can't find a valid Profiles.ini it will help you to reconstruct one. (Reconstruct Profiles.ini) 

Of course it's allowed to move your Profile folders back and forth between your removable device and local drives
available on your system. The same goes for your Profiles.ini file. 



Chapter 7 Addendum

 7.0 Sample files 



7.0 Sample files

 7.0.1 Profiles.ini 
7.0.2 Sphinx.ini 
7.0.3 Profile folder 
7.0.4 Prefs.js 
7.0.5 User.js 
7.0.6 Chrome.rdf 
7.0.7 userChrome.css 
7.0.8 userContent.css 
7.0.9 Where is? 



7.0.1 Sample of Profiles.ini 

Following is a possible user's Profiles.ini file. 

Profiles.ini
 [General] 
StartWithLastProfile=1 
[Profile0] 
Name=Ton@Hinet 
isRelative=0 
Path=E:\MailFolder\df2h2u2a.Ton@Hinet 
Default=0 



7.0.2 Sample of Profiles.ini 

Following is a possible user's the Sphinx.ini file. 

Sphinx.ini
 [00-14-A4-42-54-33] Mac address of computer system 
HelpFileDir=W:\SphinxInstallFiles\SphinxHelp.chm 
SunbirdPath=W:\Thunderbird 1.5.0\Mozilla Sunbird\ 
ThunderbirdPath=W:\Thunderbird 1.5.0\ 
ProfilesIniPath=W:\Thunderbird 1.5.0\Sphinx\ 



7.0.3 Sample of a Profile folder 

Mozilla Thunderbird stores all your personal settings, such as your mail, passwords and extensions, in a profile folder.
The profile folder is stored on your hard drive. 

Following is a sample of a possible user's Profile folder. 

Profile folder
 Main folder: 
E:\MailFolder\df2h2u2a.Ton@Hinet of course fully dependent of your user name and installation. 

Sub folders 
E:\MailFolder\df2h2u2a.Ton@Hinet\Calendar 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\browser 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\browser\content 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\browser\skin 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\communicator 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\communicator\content 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\global 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\global\content 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\global\skin 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\messenger 
E:\MailFolder\df2h2u2a.Ton@Hinet\chrome\overlayinfo\messenger\content 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{8e117890-a33f-424b-a2ea-deb272731365} 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{8e117890-a33f-424b-a2ea-deb272731365}\chrome 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{8e117890-a33f-424b-a2ea-deb272731365}\components 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{8e117890-a33f-424b-a2ea-deb272731365}\other_stuff\icons\defa
ult 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{8e117890-a33f-424b-a2ea-deb272731365}\uninstall 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5} 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\chrome 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\components 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\defaults 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\defaults\pref 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\defaults\preferences 
E:\MailFolder\df2h2u2a.Ton@Hinet\extensions\{847b3a00-7ab1-11d4-8f02-006008948af5}\uninstall 
E:\MailFolder\df2h2u2a.Ton@Hinet\Mail 
E:\MailFolder\df2h2u2a.Ton@Hinet\Mail\Local Folders 
E:\MailFolder\df2h2u2a.Ton@Hinet\Mail\msa.hinet.net 
E:\MailFolder\df2h2u2a.Ton@Hinet\Sunbird 
E:\MailFolder\df2h2u2a.Ton@Hinet\Sunbird\extensions 
E:\MailFolder\\df2h2u2a.Ton@Hinet\Sunbird\US 



7.0.4 Sample of a Prefs.js file. 

A preference is any value or defined behavior that can be set (presumably, one setting is preferable to another).
Preference changes via user interface usually take effect immediately, and are automatically saved to prefs.js in the
user profile, remaining persistent between application sessions. If you intend to edit preferences files manually, make
sure you understand preference loading and saving.
(See also : http://www.mozilla.org/catalog/end-user/customizing/briefprefs.html) 

Following is a possible user's Prefs.js. 

# Mozilla User Preferences 

/* Do not edit this file. 
* 
* If you make changes to this file while the browser is running, 
* the changes will be overwritten when the browser exits. 
* 
* To make a manual change to preferences, you can visit the URL about:config 
* For more information, see http://www.mozilla.org/unix/customizing.html#prefs 
*/ 
user_pref("calendar.alarm.text", ""); 
user_pref("calendar.alarms.defaultsnoozelength", 0); 
user_pref("calendar.alarms.emailaddress", ""); 
user_pref("calendar.alarms.eventalarmlen", 0); 
user_pref("calendar.alarms.eventalarmunit", ""); 
user_pref("calendar.alarms.onforevents", 0); 
user_pref("calendar.alarms.onfortodos", 0); 
user_pref("calendar.alarms.playsound", false); 
user_pref("calendar.alarms.show", false); 
user_pref("calendar.alarms.showmissed", false); 
user_pref("calendar.alarms.todoalarmlen", 0); 
user_pref("calendar.alarms.todoalarmunit", ""); 
user_pref("calendar.categories.names", ""); 
user_pref("calendar.date.format", 0); 
user_pref("calendar.dateformat.storeingmt", true); 
user_pref("calendar.event.defaultendhour", 0); 
user_pref("calendar.event.defaultlength", 0); 
user_pref("calendar.event.defaultstarthour", 0); 
user_pref("calendar.previousweeks.inview", 0); 
user_pref("calendar.publish.path", ""); 
user_pref("calendar.servers.reloadonlaunch", true); 
user_pref("calendar.timezone.default", "Asia/Taipei"); 
user_pref("calendar.week.d0sundaysoff", false); 
user_pref("calendar.week.d1mondaysoff", false); 
user_pref("calendar.week.d2tuesdaysoff", false); 
user_pref("calendar.week.d3wednesdaysoff", false); 
user_pref("calendar.week.d4thursdaysoff", false); 
user_pref("calendar.week.d5fridaysoff", false); 
user_pref("calendar.week.d6saturdaysoff", false); 
user_pref("calendar.week.start", 0); 
user_pref("calendar.weeks.inview", 0); 
user_pref("extensions.disabledObsolete", true); 
user_pref("extensions.enigmail.agentPath", "w:\\gpgtools\\gpg.exe"); 
user_pref("extensions.enigmail.configuredVersion", "0.89.0.0"); 
user_pref("extensions.enigmail.maxIdleMinutes", 0); 

http://www.mozilla.org/catalog/end-user/customizing/briefprefs.html)
http://www.mozilla.org/unix/customizing.html#prefs


user_pref("extensions.lastAppVersion", "0.9"); 
user_pref("intl.charsetmenu.mailview.cache", "ISO-8859-1"); 
user_pref("ldap_2.prefs_migrated", true); 
user_pref("ldap_2.servers.history.filename", "history.mab"); 
user_pref("ldap_2.servers.history.replication.lastChangeNumber", 0); 
user_pref("ldap_2.servers.pab.filename", "abook.mab"); 
user_pref("ldap_2.servers.pab.replication.lastChangeNumber", 0); 
user_pref("mail.SpellCheckBeforeSend", true); 
user_pref("mail.account.account1.server", "server1"); 
user_pref("mail.account.account2.identities", "id1"); 
user_pref("mail.account.account2.server", "server2"); 
user_pref("mail.accountmanager.accounts", "account1,account2"); 
user_pref("mail.accountmanager.defaultaccount", "account2"); 
user_pref("mail.accountmanager.localfoldersserver", "server1"); 
user_pref("mail.identity.id1.defaultEncryptionPolicy", 0); 
user_pref("mail.identity.id1.doBcc", false); 
user_pref("mail.identity.id1.doBccList", ""); 
user_pref("mail.identity.id1.draft_folder", "mailbox://tondix.tondix@msa.hinet.net/Drafts"); 
user_pref("mail.identity.id1.drafts_folder_picker_mode", "0"); 
user_pref("mail.identity.id1.enablePgp", true); 
user_pref("mail.identity.id1.encryption_cert_name", ""); 
user_pref("mail.identity.id1.encryptionpolicy", 0); 
user_pref("mail.identity.id1.escapedVCard", ""); 
user_pref("mail.identity.id1.fcc_folder", "mailbox://tondix.tondix@msa.hinet.net/Sent"); 
user_pref("mail.identity.id1.fcc_folder_picker_mode", "0"); 
user_pref("mail.identity.id1.fullName", "tondix"); 
user_pref("mail.identity.id1.organization", ""); 
user_pref("mail.identity.id1.pgpKeyMode", 1); 
user_pref("mail.identity.id1.pgpSignEncrypted", false); 
user_pref("mail.identity.id1.pgpSignPlain", false); 
user_pref("mail.identity.id1.pgpkeyId", "0x3442892F"); 
user_pref("mail.identity.id1.reply_on_top", 1); 
user_pref("mail.identity.id1.reply_to", ""); 
user_pref("mail.identity.id1.sign_mail", false); 
user_pref("mail.identity.id1.signing_cert_name", ""); 
user_pref("mail.identity.id1.smtpServer", "smtp1"); 
user_pref("mail.identity.id1.stationery_folder", "mailbox://tondix.tondix@msa.hinet.net/Templates"); 
user_pref("mail.identity.id1.tmpl_folder_picker_mode", "0"); 
user_pref("mail.identity.id1.useremail", "tondix.tondix@msa.hinet.net"); 
user_pref("mail.identity.id1.valid", true); 
user_pref("mail.root.none", "e:\\01u79ob5.Hinet@Ton\\Mail"); 
user_pref("mail.root.none-rel", "[ProfD]Mail"); 
user_pref("mail.root.pop3", "e:\\01u79ob5.Hinet@Ton\\Mail"); 
user_pref("mail.root.pop3-rel", "[ProfD]Mail"); 
user_pref("mail.server.server1.directory", "e:\\01u79ob5.Hinet@Ton\\Local Folders"); 
user_pref("mail.server.server1.directory-rel", "[ProfD]Mail/Local Folders"); 
user_pref("mail.server.server1.hostname", "Local Folders"); 
user_pref("mail.server.server1.name", "Local Folders"); 
user_pref("mail.server.server1.type", "none"); 
user_pref("mail.server.server1.userName", "nobody"); 
user_pref("mail.server.server2.ageLimit", 30); 
user_pref("mail.server.server2.daysToKeepBodies", 30); 
user_pref("mail.server.server2.daysToKeepHdrs", 30); 
user_pref("mail.server.server2.directory", "e:\\01u79ob5.Hinet@Ton\\msa.hinet.net"); 
user_pref("mail.server.server2.directory-rel", "[ProfD]Mail/msa.hinet.net"); 



user_pref("mail.server.server2.download_on_biff", true); 
user_pref("mail.server.server2.hostname", "msa.hinet.net"); 
user_pref("mail.server.server2.login_at_startup", true); 
user_pref("mail.server.server2.name", "Hinet Account"); 
user_pref("mail.server.server2.numHdrsToKeep", 30); 
user_pref("mail.server.server2.type", "pop3"); 
user_pref("mail.server.server2.userName", "tondix.tondix"); 
user_pref("mail.show_headers", 2); 
user_pref("mail.smtp.defaultserver", "smtp1"); 
user_pref("mail.smtpserver.smtp1.auth_method", 1); 
user_pref("mail.smtpserver.smtp1.hostname", "msa.hinet.net"); 
user_pref("mail.smtpserver.smtp1.port", 25); 
user_pref("mail.smtpserver.smtp1.try_ssl", 1); 
user_pref("mail.smtpserver.smtp1.username", "tondix.tondix"); 
user_pref("mail.smtpservers", "smtp1"); 
user_pref("mail.startup.enabledMailCheckOnce", true); 
user_pref("mailnews.quotingPrefs.version", 1); 
user_pref("mailnews.ui.threadpane.version", 5); 
user_pref("signon.SignonFileName", "531402.s"); 
user_pref("wallet.caveat", true); 



7.0.5 Sample of User.js 

Attention: 
This is the additional preferences file for Thunderbird and is located in your profile folder. The file does not exist by
default, so you need to create it before you can start adding your preferences. 

Manually
 Windows users: If you know how to create a file, just skip this section. Before you can create the file, you must make
sure that you can see the file type extensions in Windows. Start Explorer (just click on the My Computer icon on your
desktopor in your Start menu) and select Tools > Folder Options.... Click the View tab and uncheck the Hide
extensions for known file types option. Now, go to your profile folder and select File > New > Text Document. The
default name New Text Document.txt should be displayed. Change the name to user.js (click Yes on the file type
warning that appears). 

Using Sphinx
 Just click the Options button. If the file doesn't exist Sphinx will create one for you. 

If you want to change certain default preference values manually for a given profile, you should do so by creating
user.js in your profile directory. As previously noted, all values set in user.js take effect at program launch irrespective
of changes from previous session. 
(See also: http://www.mozilla.org/catalog/end-user/customizing/briefprefs.html) 

Following is a possible user's User.js file. 

// Change the reply header 
// 0 - No Reply-Text 
// 1 - "[Author] wrote:" 
// 2 - "On [date] [author] wrote:" 
// 3 - User-defined reply header. Use the prefs below in conjuction with this: 
user_pref("mailnews.reply_header_type", 3); 
// If you set 3 for the pref above then you may set the following prefs. 
user_pref("mailnews.reply_header_authorwrote", "%s said the following"); 
user_pref("mailnews.reply_header_ondate", "on %s"); 
user_pref("mailnews.reply_header_separator", " "); 
user_pref("mailnews.reply_header_colon", ":"); 
// The end result will be [authorwrote][separator][ondate][colon] 
user_pref("mail.prompt_purge_threshhold", true); 
user_pref("mail.purge_threshhold", 100); 

http://www.mozilla.org/catalog/end-user/customizing/briefprefs.html)


7.0.6 Sample of Chrome.rdf file. 

Following is a possible user's Chrome.rdf file. 























7.0.7 Sample of userChrome.css 

Atention: 
This file sets the display rules for various elements in the Thunderbird user interface and is located in the sub-folder
called chrome in your profile folder. As with user.js, this file does not exist by default, so you need to create it before
you can start adding your preferences. There's actually an example file that exists by default, called
userChrome-example.css. Basically, you can just rename that file by removing the -example part. 

Manually
 Windows users: If you know how to create a file, just skip this section. Before you can create the file, you must make
sure that you can see the file type extensions in Windows. Start Explorer (just click on the My Computer icon on your
desktop or in your Start menu) and select Tools > Folder Options.... Click the View tab and uncheck the Hide
extensions for known file types option. Now, go to your profile folder and select File > New > Text Document. The
default name New Text Document.txt should be displayed. Change the name to user.js (click Yes on the file type
warning that appears). 

Using Sphinx
 Just click the Options button. If the file doesn't exist Sphinx will create one for you. 

Following is a possible user's userContent.css. 

/* Make menus XP style */ 
menupopup, popup { 
border: 1px solid ThreeDShadow !important; 
-moz-border-left-colors: ThreeDShadow !important; 
-moz-border-top-colors: ThreeDShadow !important; 
-moz-border-right-colors: ThreeDShadow !important; 
-moz-border-bottom-colors: ThreeDShadow !important; 
padding: 2px !important; 
background-color: Menu !important; 
} 
menubar > menu { 
border: 1px solid transparent !important; 
padding: 2px 5px 2px 7px !important; 
margin: 0 !important; 
} 
menubar > menu[_moz-menuactive="true"] { 
background-color : Highlight !important; 
color: HighlightText !important; 
} 

(See also: http://developer.mozilla.org/en/docs/XUL_Tutorial:Modifying_the_Default_Skin) 

http://developer.mozilla.org/en/docs/XUL_Tutorial:Modifying_the_Default_Skin)


7.0.8 Sample of userContent.css 

Attention
This file sets the display rules for web content and is located in the sub-folder called chrome in your profile folder. As
with user.js, this file does not exist by default, so you need to create it before you can start adding your preferences.
As with userChrome.css, there is an example file that exists by default, called userContent-example.css. Basically, you
can just rename that file by removing the -example part. 

Manually
 Windows users: If you know how to create a file, just skip this section. Before you can create the file, you must make
sure that you can see the file type extensions in Windows. Start Explorer (just click on the My Computer icon on your
desktop or in your Start menu) and select Tools > Folder Options.... Click the View tab and uncheck the Hide
extensions for known file types option. Now, go to your profile folder and select File > New > Text Document. The
default name New Text Document.txt should be displayed. Change the name to user.js (click Yes on the file type
warning that appears). 

Using Sphinx
 Just click the Options button. If the file doesn't exist Sphinx will create one for you. 

Following is a possible user's userContent.css. 

/* Quote Levels Colors */ 
blockquote[type=cite] { 
color: navy !important; background-color: RGB(245,245,245) !important; 
} 
blockquote[type=cite] blockquote { 
color: maroon !important; background-color: RGB(235,235,235) !important; 
} 
blockquote[type=cite] blockquote blockquote { 
color: green !important; background-color: RGB(225,225,225) !important; 
} 
blockquote[type=cite] blockquote blockquote blockquote { 
color: purple !important; background-color: RGB(215,215,215) !important; 
} 
blockquote[type=cite] blockquote blockquote blockquote blockquote { 
color: teal !important; background-color: RGB(205,205,205) !important; 
} 



7.0.9 Where is? 

Profiles.ini
By default Mozilla Thunderbird will put your Profiles.ini file into the directory: 
* On Windows XP/2000, the path is usually %AppData%\Thunderbird\Profiles\xxxxxxxx.default\, where xxxxxxxx is
a random string of 8 characters. 
Just browse to C:\Documents and Settings\[User Name]\Application Data\Thunderbird\Profiles\ and the rest should
be obvious. 
* On Windows 95/98/Me, the path is usually C:\WINDOWS\Application
Data\Thunderbird\Profiles\xxxxxxxx.default\ 
If you installed Sphinx just see the topic: double clicking folder label

 Sphinx.ini
Normally Sphinx.ini will be located in the folder Sphinx (NOT the folder in which you installed Sphinx itself) which
can be found in Thunderbird's main folder. 

Profile folder
Depending on your installation your Profile folder should look like:
E:\MailFolder\df2h2u2a.Ton@Hinet of course fully dependent on your user name and installation. 

SphinxAutoBackupInfo.ini
Located in the folder SphinxAutoBackupInfo which resides in your Profile folder. 

SphinxTrashBin
Located in your Profile folder. 

SphinxZippedMail
Located in your Profile folder. 

Prefs.js, User.js and userChrome.css are all located in your Profile folder 
Attention: user.js and userChrome.css are not automatically created by TB. 
You have to do it yourself either manually or by using Sphinx. 
(see: User.js and userChrome.js ) 

Chrome.rdf and userContent.css
Depending on your installation both files are located in the folder: E:\MailFolder\01u79ob5.dr. Ton H. Dix\chrome 

For more information see: http://www.mozilla.org/support/thunderbird/edit#profile 

http://www.mozilla.org/support/thunderbird/edit#profile


7.1 Miscellaneous

 7.1.1 Registry key 
7.1.2 Security alert 



8.1 Registry key 

If the user has permission to write to the registry, Sphinx will create the following entry: 
Location: HKEY_CURRENT_USER\Sphinx 
ValueName : SphinxPath 
ValueData : W:\Thunderbird 1.5.0\ depending on your installation 

In this way the path to Sphinx.ini will be found immediately and a drive scan won't be necessary if all info found in
Sphinx.ini is valid and not corrupted. 



8.2 Security alert 

Be alert regarding your Profile folders. Nether Thunderbird nor Sphinx will protect your Profile folders from 'evil'
doings. Especially if you are using a Fat or Fat32 file system there will be no protection at all. (With NTFS you're able
to encrypt your Profile folders.) This is one of the main reasons Sphinx will operate with locally installed files only (no
hacking by system administrators). The only time people will be able to 'borrow' your Profile folders will be at runtime
or if your system is stolen. To protect your files from the last, we recommend putting your Profile folders on a virtual
encrypted disk, which you only decrypt when you want to start Sphinx. 



Chapter 8 Extra

 8.0 Move current installation 
8.1 Reinstalling Windows OS 



8.0 Move a complete current installation

For the purposes of this explanation we assume the following: You want to move your complete installation, including
your mail folders etc, to drive d:\ 
How to proceed?.

Step 1: Install Thunderbird on the drive you want to use for your new installation. For this explanation we assume
d:\Thunderbird

Step 2: Start your current installation of Sphinx.

Step 3: Use Sphinx Move Profiles.ini (Move Profiles.ini) to move your Profiles.ini file to drive d:\, preferable into the
folder you installed Thunderbird i.g. d:\Thunderbird.

Step 4: Use Sphinx Move option in Copy/Move Profile (Copy/Move Profile).
Use the drive of your new installation in this case drive d:\ and a folder of your choice. For this explanation we will use
d:\Mailfolder.

Step 5: Terminate Sphinx.

Step 6: Install a version of Sphinx on the drive of your new installation, in our case drive d:\ into a folder of your
choice, but don't use the folder in which you installed Thunderbird.

Step 7: Start the new installation of Sphinx. During startup of Sphinx define new settings as follows: Thunderbird.exe
now on drive d:\Thunderbird, Profiles.ini now on drive d:\Thunderbird. 

That's all. The next time you click a Sphinx icon on your desktop, Quick launch bar etc, Sphinx will use your new
installation. 



8.1 Reinstalling Windows OS

If you want to reinstall Windows OS please follow the next steps regarding Sphinx.

Step 1: make a complete back-up of all your Profiles.
Remember the drive(letter) your Profiles are stored on!
If you don't know where your Profiles are stored see: Double clicking folder label.
(Those back-ups should of course reside on an external medium.)

Step 2: Reinstall your Windows OS. If you decide to repartition your drives be sure to leave the drive letter on which
your profiles were originally located available. 
The back-ups made in Step 1 contain full file paths.

Step 3: Reinstall Thunderbird/Sunbird and Sphinx.

Step 4: Run Sphinx.
Sphinx will display the window below.

CLick to restore your back-ups first.
Don't alter the full file paths as defined in the back-ups made in Step 1.

Step 5: After having restored your back-ups, choose one of the three options in the above window and click 
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